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The study of plant growth and development has long relied on experimental techniques using dead, fixed tissues and lacking proper cellular
resolution. Recent advances in confocal microscopy, combined with the development of numerous fluorophores, have overcome these issues
and opened the possibility to study the expression of several genes simultaneously, with a good cellular resolution, in live samples. Live
confocal imaging provides plant biologists with a powerful tool to study development, and has been extensively used to study root growth

and the formation of lateral organs on the flanks of the shoot apical meristem. However, it has not been widely applied to the study of flower
development, in part due to challenges that are specific to imaging flowers, such as the sepals that grow over the flower meristem, and filter out
the fluorescence from underlying tissues. Here, we present a detailed protocol to perform live confocal imaging on live, developing Arabidopsis
flower buds, using either an upright or an inverted microscope.

Video Link

The video component of this article can be found at https://www.jove.com/video/55156/

Introduction

Most of the plant body forms post-embryonically from groups of stem cells situated at or near the tip — or apical meristems — of the shoots

and roots. All the above-ground structures of the adult plant derive from the shoot apical meristem (SAM), which continuously produces lateral
organs on its flanks: leaves during the vegetative phase, and flower meristems (FMs) after it transitions to the reproductive phase. FMs in

turn develop into flowers. While the Arabidopsis SAM produces lateral organs one at a time, in an iterative, spiral pattern, FMs produce four
types of floral organs within four whorls, in a partially synchronous manner, with multiple developmental programs unraveling simultaneously.
The genetlc networks underlying the specification of the identity of the different floral organs have been partially deciphered (for reviews, see
references ™ ) but many aspects of flower development, such as floral organ positioning and the definition of boundaries between whorls, remain
poorly understood.

Early molecular genetic studies of plant development mostly relied on techniques such as in situ hybridization and GUS reporters to analyze
gene expression. While these methods have provided a wealth of information and greatly contributed to our understanding of plant growth and
flower development, there are important limitations: they lack good cellular resolution, do not allow for the easy observation of the expression
pattern of multiple genes in the same samples, and importantly, can only be applied to dead, fixed tissues. Recent advances in confocal
microscopy have overcome these limitations, and provide developmental biologists with a powerful tool to investigate the processes underlying
plant morphogenesis. In particular, confocal microscopy allows for the observation of live tissues and organs throughout their formation, which is
critical to fully understand a quintessentially dynamic process such as development.

Live confocal i magmg has been extensively used to analyze the aerial growth of plants and the production of lateral organs by the SAM

(e.g. references® ) but with the exception of a few reports (e.g. references’®%1° ), it has not been widely applied to the study of flower
development. Protocols for live confocal imaging of the SAM are available (e.g. references’" ) and provide a good base for how to image the
developing flower buds that surround the SAM. However, imaging flower buds presents specific challenges: for instance, flower buds quickly
become bigger than the SAM, and at stage 4, sepals start covering the FM (stages as described in reference’ ) and dimming the fluorescence
from underlying tissues (Figure 2A). Here, we provide a detailed protocol explaining how to perform live confocal imaging on developing
ArabldopS|s flower buds using either an upright or an inverted microscope and a water-dipping lens. We previously published this protocol in
reference™

Protocol

1. Media and Dishes Preparation

1. Prepare dissecting dishes by filling round plastic boxes (approximately 6 cm wide, 2 cm deep) to 0.5 cm with 2% agarose.
2. Prepare imaging dishes.
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1. For an upright confocal microscope, fill rectangular plastic hinged boxes (approximately 7 cm long, 4.5 cm wide, 3 cm deep) to 0.5 cm
with imaging medium (see section 1.3, "Imaging medium"; Figure 1F).

2. For an inverted confocal microscope: fill small Petri dish (approximately 3.5 cm wide, 1 cm deep) exactly to the brim with imaging
medium (see section 1.3, "Imaging medium"; Figure 1G).

3. Prepare imaging medium.
1. For single point imaging, use 1% agarose.
2. For time-lapse experiments, use apex growth medium (0.5x Murashige and Skoog basal salt mixture without vitamin, 1% sucrose,
0.8% agarose, pH 5.8 with potassium hydroxide solution, supplemented with vitamin [0.01% myo-inositol, 0.0001% nicotinic acid,
0.0001% pyridoxine hydrochloride, 0.001% thiamine hydrochloride, 0.0002% glycine] and cytokinin [500 nM N6-benzyladenine])15.

2. Plant Growth

1. Sow sterilized seeds on MS plates (0.5 or 1x Murashige and Skoog basal salt mixture without vitamin, 0.8% agar, pH 5.8 with potassium
hydroxide solution) with appropriate selection. Place plates in long day (16 h light) or continuous day, 16-22 °C conditions for two weeks.

2. Transplant seedlings onto soil with sufficient spacing to allow robust development. Place plants in short day, 16-22 °C conditions for three
weeks.
NOTE: Growing plants in long day or continuous day conditions directly after transplanting results in premature flowering and inflorescences
that are less vigorous, and much harder to dissect. Similarly, leaving plants under short day conditions for more than three weeks results in
day length-independent flowering and inflorescences that are less vigorous.

3. Transfer plants to long day (16 h light) or continuous day, 16-22 °C conditions until they flower. Shoot apices are easiest to dissect when the
inflorescence is 2-10 cm long.

3. Dissection of the Shoot Apex

1. Optional: Using a fine sharpening stone and a drop of light oil, sharpen forceps under the stereomicroscope to make them blade-like, not
point-like.

2. Remove siliques, older flower buds and secondary inflorescences from the primary inflorescence by pushing the base of the peduncles with
the forceps until they break. Remove as many flowers as possible without magnification (Figure 1, compare A and B).

3. Using forceps, pierce a vertical hole in the agarose of a dissecting dish, cut off the last 0.5 cm of the inflorescence and stick it vertically in the
agarose. The remaining flower buds must be above the agarose surface.

4. Fill the imaging dish with sterile, de-ionized water so that the shoot apex is fully immersed. Place the dissecting dish under the
stereomicroscope, and remove the air trapped around the shoot apex by creating water jets with a 1,000 uL pipette (Figure 1, compare C
and D).

5. Under the stereomicroscope, use the forceps to remove flower buds that are not to be imaged by pushing on the base of the peduncle or the
top of the bud until the peduncle breaks (Figure 1E). It is important that the peduncles break cleanly at the junction with the stem, as leftover
peduncles hinder the removal of the young flower buds.

6. Ifimaging only flower buds stage 5 and younger (Figure 2A), remove the water before dissecting stage 6-8 flower buds. If imaging flower
buds stage 5 and older, proceed to sepal ablation (see section 5.1). Otherwise, proceed to step 3.7.

7. Using forceps, pierce a vertical hole in the medium of an imaging dish, and stick the dissected apex upright in the medium, so that only
the shoot apical meristem and surrounding flower buds are above the surface of the medium. Depending on which flower bud(s) are to be
imaged, it may be necessary to slightly tilt the sample, as flower buds are not necessarily oriented exactly like the stem (Figure 2A).

8. Proceed to staining the sample if needed. If not staining and/or imaging the sample right away, add water and close the imaging dish to
prevent dehydration. If using an inverted microscope, place the imaging dish in a transparent plastic box and close it.
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Figure 1: Preparation of the shoot apices for live confocal imaging. (A-E) Dissection of a shoot apex for imaging. Inflorescence before

(A) and after (B) removal of siliques and older flowers. (C-D) Shoot apex immersed in water in the dissecting dish, with an air bubble trapped
at the tip (C) and after removal of the air bubble (D). (E) Shoot apex in the dissecting dish, after dissection of flower buds older than stage 5.
(F-G) View of shoot apices in the imaging dish, on the stage of an upright (F) and inverted (G) confocal microscope. In (F), a 40X water-dipping
lens is positioned above one of the apices, with the tip of the lens immersed in water. In (G), the shoot apex is positioned upside down above
the 40X water-dipping lens, with a water column connecting the imaging medium to the tip of the lens. The smaller panel in (F) shows a higher
magnification view of the area in the red rectangle, with a shoot apex inserted in imaging medium; red and blue lines indicate the surface of the
medium and water, respectively. (H-1) Examples of custom-made devices that allow adding more water at the tip of the water-dipping lens: a
silicon rubber sleeve made from a spark plug boot (H), and a makeshift sleeve made from the finger of a powderless latex glove (G). Scale bars
=0.5cmin (A)and (B), 0.1 cmin (C) and (D), and 100 um in (E). This figure was initially published in reference’. Please click here to view a
larger version of this figure.

4. Staining

NOTE: Cell walls or plasma membranes can be stained with propidium iodide or FM4-64, respectively, to achieve cellular resolution during
imaging. Alternatively, reporter lines with fluorescent proteins tagged to the plasma membrane can be used®®.

1. Remove water from the imaging dish, and ensure the surface of the medium is dry to avoid diluting the dye.
Under the stereomicroscope, apply 20 to 30 pL of either 1 mg/mL propidium iodide solution, or 80 ug/mL FM4-64 solution to the dissected
apex with a 10 yL pipette. Make sure the whole sample is covered in dye to ensure a homogeneous staining.

3. Stain for 2 min if using propidium iodide, or 20 min if using FM4-64.

4. Rinse twice with sterile, deionized water.

5. Sepal Ablation

NOTE: At stage 4, sepal primordia start covering the FM. As they grow, they filter out the fluorescence from underlying tissue, and hinder the
imaging process. Sepals can either be removed manually using a metal pin mounted on a pin-vise, or prevented to grow using laser ablation on
emerging sepal primordia. Alternatively, it is possible in some cases to use mutants such as apetala7-1, in which sepals are missing or replaced
by leaf-like organs that do not cover the FM while the central part of the flower develops normally (Figure 2F)17.

1. Sepal ablation on flower buds stage 5 and older using a pin-vise holding a straight metal needle (Figure 2, E1-E2)
1. Place the dissecting dish with the dissected apex under the stereomicroscope, and set the magnification to maximum. Immerse the
shoot apex in sterile, deionized water, or alternatively, use a 1,000 uL pipette to apply water to the shoot apex regularly while dissecting
the sepals.
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2.

3.
4.

5.

With the pin-vise, position the pin on top of the abaxial sepal, tangentially relative to the shoot apex. Gently push the sepal away from
the shoot apex until it breaks away from the flower bud.

Proceed similarly with the adaxial sepal, but push the sepal towards the shoot apex.

Proceed similarly with the lateral sepals, but position the pin radially relative to the shoot apex, and push the sepals to the side, away
from the flower bud.

Immerse the shoot apex in sterile, deionized water for a few minutes to prevent dehydration.

2. Laser ablation of sepal primordia at stage 3-4 (Figure 2, C5-D5)

1.

2.

Place the imaging dish with the stained, dissected apex on the confocal microscope stage. Locate and focus on the apex as if
preparing to image it (see section 6, "imaging setup").

Using the laser ablation system software, define the ablation zone, which corresponds to the crest and tip of the emerging sepal
primordia before they start covering the flower meristem (typically, at stage 3 for abaxial and adaxial sepals, and at late stage 3/early
stage 4 for lateral sepals).

Set laser power and dwelling time to appropriate parameters to ablate enough cells without inflicting too much damage to the
underlying tissues. Typically, depending on the laser ablation system used, proper parameters initially need to be identified through
a trial-and-error process to ensure that enough cells are removed to prevent the sepals to subsequently grow over the FM, without
affecting the rest of the flower bud. Using too much laser power and dwelling time results in damages to the center of the flower,
affecting its growth and/or survival. Once the proper parameters have been identified, they can be reused for subsequent experiments.
NOTE: If the initial ablation proves insufficient, it is possible to proceed to a second ablation on the following days (Figure 2, C4 and
D2).

6. Imaging Setup

1. Use an upright microscope.

1.

2.

3.
4.

5.

Fill the imaging dish with the dissected apices with sterile, deionized water so that the surface of the medium is covered in 2.5-5 mm
water (Figure 1F). Completely immerse the samples.

NOTE: When imaging with an upright microscope, several apices can be placed in the same imaging dish. However, if the imaging
process lasts more than an hour, propidium iodide tends to be diluted, and some samples might need re-staining prior to imaging.
Place the imaging dish on the microscope stage (Figure 1F). Lower the water-dipping lens and raise the stage so that the tip of the
lens dips in the water. Proceed cautiously so as not to crush the dissected apices or dip the lens into the imaging medium.

If an air bubble is trapped at the tip of the lens, make water jets with a 1,000 uL pipette to remove it.

Under epifluorescence illumination, position one of the dissected apices into the lens field using the XY controller. Look through the
eyepieces and focus on the sample using the Z controller. Proceed cautiously in order not to crush the sample.

Using the confocal microscope software, zoom on the flower bud to be imaged, and proceed to imaging your sample.

2. Use an inverted microscope.

1

2.
3.
4.

5.
6.

7.

Using a 1,000 pL pipette, put a drop of sterile, deionized water on the tip of the lens.

Hold the imaging dish upside-down, and with a 1,000 pL pipette, add a drop of sterile, deionized water to the dissected apex.

Place the imaging dish upside-down on the microscope stage (Figure 1G). Proceed cautiously so as not to crush the sample.

Under epifluorescence illumination, position the dissected apex over the tip of the lens using the XY controller. With the Z controller,
carefully lower the stage until the sample reaches the drop of water at the tip of the lens. A water column should form between the tip of
the lens and the medium.

If the water column does not form, carefully add a drop of water to the sample with a 1,000 uL pipette. Add makeshift sleeves to the
lens in order to add more water at its tip, which facilitates the establishment and maintenance of the water column (Figure 1H and 1l).
Under epifluorescence illumination, look through the eyepieces and focus on the sample using the Z controller. Proceed cautiously so
as not to crush the sample.

Using the confocal microscope software, zoom on the flower bud to be imaged, and proceed to imaging the sample.

3. If performing time-lapse experiments, pour the water out of the imaging dish and close it to prevent dehydration in between time points. Place
the imaging dish with the samples in long day (16 h light) or continuous day, 16-22 °C conditions. Re-stain samples before each time point.
NOTE: While cells in developing floral organs can divide faster, cells in the floral meristem divide once or twice every second day, and cell
lineages are easy to track with time points every 24 h. However, if need be, it is possible to image the samples every six hours.

7. Considerations on the Imaging Parameters

NOTE: How to set up the imaging parameters depends a lot on the confocal system used. Below are suggestions for some of these parameters
that can bs used with any confocal microscope. For more considerations on the imaging parameters, see the Discussion section and
reference .

1. For the XY resolution: use 1,024 x 1,024 for a good cellular resolution. Alternatively, use 512 x 512 to reduce imaging time, at the expense of
the resolution.

2. For the Z resolution: set the step-size to 0.5-1.5 ym. Lowering the step-size increases the Z resolution but also the imaging time.

3. For the pinhole: set the pinhole to 1-1.5 airy units. Increasing the pinhole increases the intensity of the signal, but also the noise from non-
focal planes.

8. Visualization of Confocal Data

1. Turn still images of time points of flower development into a movie.
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Open the still images (in jpeg or tif format) in the software (e.g., Fidi).

Go to Image > Stacks > Images to Stack. The open images will be grouped in a stack.

If the order of the images in the stack does not correspond to the chronological order, use the Stack Sorter plugin (Plugins > Stacks >
Stack Sorter) to reorder them.

4. To turn the stack into a movie, go to File > Save As > AVI.

Representative Results

Figure 2 presents different views of confocal Z-stacks of live Arabidopsis flower buds expressing different fluorescent reporter genes, and
stained with either propidium iodide (Figure 2, A-C5 and G) or FM4-64 (Figure 2, E1-F) to provide a clear cellular resolution. Most confocal
systems allow for the imaging of two fluorophores with non-overlapping emission spectra such as GFP or YFP together with either propidium
iodide or FM4-64 (Figure 2A-2F). The best confocal systems are also able to separate multiple fluorophores with partially overlapping emission
spectra in the same samples, such as GFP and YFP, and dsRed and propidium iodide (Figure 2G).

wh =

Three examples of time-lapse experiments are presented in Figure 2 and show flower buds developing normally after sepal ablation was
performed either with a laser ablation system (Figure 2, C1-C5 and D1-D5) or manually with a pin-vise and a metal pin (Figure 2, E1-E2). Note
that the flower bud shown in Figure 2, E1-E2 is from a superman-1 mutant plant, which is why carpel primordia are not observed at the center
of the bud at stage 7. Laser ablation of emerging sepal primordia of the flower bud shown in Figure 2, C1-C5 prevents them from covering the
FM, which can still be imaged at stage 5 (Figure 2, C5). Conversely, in the case of the flower bud shown in Figure 2, D1-D5, laser ablation only
delayed sepal growth, but sepals eventually grew to cover most of the FM by stage 5 (Figure 2, D5). On the contrary, if too much laser power
and dwelling time is used during laser ablation, damage spreads to the central part of the flower and affects its growth and sometimes results in
the subsequent death of the whole flower bud.
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Figure 2: Visualization of confocal Z-stacks of live flower buds. A and B2 are transparency views; B1 and B4-G are maximum intensity
projections; B3 is an orthogonal slice view. (A-E2) flowers expressing a Venus reporter for the APETALA3 gene (green); cell walls were stained
with propidium iodide (red, except for B4, green). (A) Inflorescence; numbers indicate floral stages; sepals in stage 4 and 5 flowers filter out

the fluorescence of the Venus reporter, which normally forms a ring. Note that some flower buds appear tilted compared to the inflorescence.
(B1-B4) Four different views of the same confocal Z-stack of a stage 5 flower bud: maximum intensity projections (B1 and B4) with Venus

signal intensity coded with pixel intensity in the green color (B1) or with fire color code (B4; color code is shown at the bottom of the panel);
transparency view (B2) and orthogonal slice view (B3; the XY, XZ and YZ orientation of the slices is indicated in the panel). (C1-C5) 4-day time-
lapse of an individual flower bud from stage 3 to stage 5; laser ablations (marked as white traits) performed on day 1 and day 3 were sufficient

to prevent the sepals from covering the center of the flower bud at stage 5. (D1-D5) 4-day time-lapse of an individual flower bud from stage 3 to
stage 5; laser ablations performed on day 1, 2 and 3 were insufficient to prevent the sepals from covering the center of the flower bud. (E1-E2)
Individual flower bud after manual removal of the abaxial and adaxial sepals (E1), and of all sepals (E2); white arrowheads indicate remaining
sepals; white asterisks indicate scars resulting from the removal of the sepals. (F) stage 7 apetala1-1 flower expressing a DR5-3xVenusN7
reporter18 (green); plasma membranes were stained with FM4-64 (red); blue arrowheads indicate the leaf-like structures that replace sepals and
do not cover the flower bud. (G) Stage 4 flower bud expressing a fluorescent GFP reporter for DORNROSCHEN-LIKE’ (green), a Venus reporter
for SUPERMAN (red) and a dsRed reporter for CLAVATA3" (cyan); cells walls were stained with propidium iodide Sgrey). d: day; st: stage. Scale
bars = 25 ym; scale is identical in B1, B2 and B4, in C1-C5 and in D1-D5. This figure was modified from reference'®. Please click here to view a
larger version of this figure.

Here, we provide a protocol for the imaging of live, developing Arabidopsis flower buds with a confocal microscope and a water-dipping lens.
While this can be done with either an upright or an inverted microscope, it is easier and faster to use the former. It is also worth noting that
different confocal systems vary significantly in terms of speed, sensitivity, and ability to separate wavelengths. The best confocal microscopes
now allow to image several different channels (e.g. GFP, YFP, dsRed and propidium iodide; Figure 2G) in the same samples. Some confocal
microscopes are equipped with a spectral detector, which can collect the fluorescence from several fluorophores simultaneously and separate
them afterwards. When using a regular detector, however, a set of lasers and filters must be used to excite and separate the fluorescence from
different fluorophores. Some fluorophores have fully distinct emission spectra (e.g. CFP and YFP), and can be imaged simultaneously. Other
fluorophores have partially overlapping emission spectra (e.g. GFP and YFP), and usually need to be imaged separately, which increases
imaging time. Imaging close fluorophores also often requires restricting how much of the spectrum is collected for each channel to prevent
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fluorescence from one fluorophore from leaking into another channel. This causes a loss of intensity of the collected signal, which can be
compensated by an increase in laser power and gain. However, prolonged imaging time and increased laser power may bleach and/or damage
the sample. Increased laser power and/or gain may also increase background noise. Optimization of signal intensity, resolution and imaging time
for each sample is done through a trial-and-error process, and involves permanent trade-offs.

This protocol explains how to perform live confocal imaging of flower buds developing on the flanks of a dissected shoot apex. It may be argued
that the fact that the shoot apex is not connected to the rest of the plant and grows in a medium containing cytokinins might affect SAM and
flower development. However, this medium was designed empirically through a trial-and-error process to ensure the dissected shoot apical
meristems produce new flower buds at the normal plastochron, and that these flower buds develop normally . Similarly, sepal dissection does
not appear to affect gene expression patterns or the development of the rest of the flower. Other protocols detail how to perform live confocal
imaging of the SAM still attached to the rest of the plant (e.g. reference’ ) Such protocols could be adapted to, and offer a useful alternative for
the imaging of developing flowers, particularly when studying cytokinin-related processes. They present several disadvantages however: the
stem elongates and twists, and changes the orientation of the flower buds; and while imaging a shoot apex attached to the rest of the plant works
well with an upright microscope, it is much more complicated to do so with an inverted microscope.

Immersion lenses have a better numerical aperture (NA) than "dry" lenses (i.e. lenses that are separated from the sample by air), and therefore
provide a finer resolution of the sample, which is critical when using a confocal microscope. Using a water-dipping lens thus provides a much
better NA than a dry lens, while preventing the shoot apex from dehydrating during the imaging process. While glycerin and oil lenses have an
even higher NA than water lenses, they require the use of a coverslip, which is very unpractical with a sample the size of a shoot apex, which
also keeps growing during time-lapse experiments. Given the size of the samples (depending on the floral stages, stacks can be over 150 ym
thick), it is also important to use a lens with a long working distance. We typically use a 20 or 40X lens with a NA of 1 and a working distance of
1.7-2.5 mm.

Confocal microscope software offers several ways to visualize confocal data, including three-dimensional reconstructions (Figure 2, B1, B2 and
B4) and slice views (Figure 2, B3). While the most commonly used three-dimensional views are maximum intensity projections of the confocal
Z-stacks (Figure 2, B1 and B4), some software (e.g. ZEN and Imaris) also offer transparency views that filters out the signal from the deeper
parts of the sample (Figure 2, B2), which can be useful when looking at processes taking place, or genes expressed in, the epidermal layer.
Signal intensity can either be coded with a single color (Figure 2, B1), using pixel intensity, or using a color code (Figure 2, B4).

Live confocal imaging not only offers valuable qualitative insights into flower development, it also potentlally provides developmental biologists
with a wealth of quantitative data. Different software (e.g. Imaris, FidJi, MARS-ALT, MorphographX 15.20. ) allows for the quantification of the
number or the volume of cells expressing one or several reporters, or the level of expression of a reporter in different cells. Such software can
also be used to perform automatic cell segmentation, track cell lineages and quantify growth. ThIS dlfferent software offers similar tools, but
also differs in many ways. MARS-ALT and MorphoGraphX were designed specifically for plants 0.21 , unlike Imaris and FiJi. MorphoGraphX
only allows for the segmentation and analysis of the epidermal layer, while Imaris and MARS-ALT aIIow for the segmentatlon and analysis of
the whole sample. However, MARS-ALT requires the prior imaging of the same sample from three different angles and Imaris only requires a
single stack. Access to quantitative information is critical to further our understanding of flower development.
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